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Introduction

1.0 Introduction

The Zebra FX Series Embedded Java SDK User Guide for Windows describes the detailed steps about
how to use the FX Series Embedded Java SDK to develop, debug and package Embedded application
using fixed RFID reader FX9600 and FX7500 on Windows.

This user guide covers the following topics

e Zebra Java SDK describes how to create, build, and debug an embedded Java application,
and how to create Start and Stop script files for the deployment packages used to install the
application onto the FX RFID Readers on Windows 10 and windows 7 OS.

e Embedded Sample RFID Java Application from scratch, create, build and debug

® JAR File creation using Manifest file

e Sample Hello world Example from scratch, create, build and debug

Note: Uninstall any older Zebra SDK if installed on Windows host machine.

ZEBRA TECHNOLOGIES



' ZEBRA

REVISION HISTORY

2.0 Revision History

REV | DESCRIPTION DATE AUTHOR

1.0 Steps and procedure to develop, 19-June-2019
debug and package embedded
application for Zebra sample

application

1.1 ® Updated the SDK file namesin | 24 June 2019
new format

® Java 8 installation added in
prerequisites

1.2 ® ‘dos2unix’ tool information 30 April 2020
added for script file format
conversion.

® Execution steps on sample app.
At reader after installation.
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PRE-REQUISITE

3.0 Pre- Requisites

e Host Machine running with Windows 10 Pro or Windows 7.

e Host Machine with 16GB Ram preferred with 40GB free space, Intel Core 17 CPU.
e  Zebra-FXSeries-Embedded-SDK-Java-Windows_V1.0.1.zip file provided by Zebra.
e |Install 7-Zip in the host machine. This is required to unzip file.

e RFID Reader FX Series Firmware Version 3.x.x or higher

e Ensure latest Java (Java 8) is installed in the host machine
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JAVA SDK INSTALL

4.0 SDK Install

This section describes the steps involved for installing Zebra Java SDK on Windows host machine.

4.1 Install SDK zip file

Copy the Zebra-FXSeries-Embedded-SDK-Java-Windows_V1.0.0.zip file provided by Zebra in any of

the drives folder.

Figure 1 : Zipped Fil

Mame

g' Zebra-FXSeries-Embedded-5DK-Java-Windows_V1.0.0

e

Date modified Type Size

6/27/2019 &:04 AM  Compressed (zipped) Folder 492 136 KB

Right Click on the zip file, select 7-zip and select Extract files.

Figure 2 : 7-Zip

MName

' Zebra-FXSeries-Embedde

%% %y

Date modified

d-5DK-Java-Windows_V1.0.0

6/27/2019 6:04 Al

Open

Open in new window

Extract All...
CRCSHA
JL Scan selected items for viruses
Pin to Start
12 Share
Open with...

Restore previous versions

Type Size

Compressed (zipped) Folder 492,136 KB

Send to

Cut
Copy

Create shortcut
Delete

Rename

Open archive
Open archive >
Extract Here
Extract to "Zebra-FXSeries-Embedded-SDK-Java-Windows_V1.0.0v"

Test archive

Add to archive...

Compress and email...

Add to "Zebra-FXSeries-Embedded-SDK-Java-Windows_V1.0.0.zip. 72"

Compress to "Zebra-FXSeries-Embedded-SDK-Java-Windows_¥1.0.0.zip.7z" and email
Add to "Zebra-FXSeries-Embedded-SDK-Java-Windows_V1.0.0.zip.zip"

Compress to "Zebra-FXSeries-Embedded-SDK-Java-Windows_¥1.0.0.zip.zip" and email

Properties
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Select the folder where the zip file needs to be extracted to, for example, the following screenshot

shows the zip file being extracted to C:\ drive user path.

Note : Please make sure the checkbox under “Extract to” is unchecked. Also, in Windows 7, there is
no text box beside the highlighted checkbox below, please proceed further and click OK.
Figure 3 : 7-Zip extraction

Extract : Ch\Zebra\Zebra-FX5Series-Embedded-5DK-Java-Windows_V1.0.0.zip »
BExtract to:
|C\Zebra\ |
Password
Path mode: | |
Full pathnames e

[] Show Password
[[] Bliminate duplication of root folder

Owerwrite mode: [] Restore file security
Ask before averwrite s

Click on the unzipped folder of Zebra-FXSeries-Embedded-SDK.

Figure 4 : Unzipped Folder

r Windows [(C:) »

Include in library - Share with - Compatibility files Mew folder
Marme - Date modified Type Size
3 D ceerpooemar e g e
. Program Files 02-01-201911:54 File folder
. Program Files (x86) 18-12-2018 OF:27 File folder
ProgramData 11-11-2018 08:51 File folder
. Project_Docs A7-03-2016 12:48 File folder
. python 19-01-2018 15:03 File folder
. searchplugins 12-04-2016 14:37 File folder
. SenchaTest 11-07F-2018 15:0=2 File folder
. SenchaTraining 22-02-2017F 17:27 File folder
. SWSETUP 08-02-2016 11:05 File folder
. SymCache 21-07-2017 14:48 File folder
. TeamCity 16-08-2017F 13:06 File folder
. Temp 30-07-2017 08:18 File folder
2 TFTP-Root 12-10-2016 13:59 File folder
. UsBE 01 -05-2016 08:21 File folder
. Users 02-10-2017F 15:17 File folder
Jousr 11-02-2016 12:45 File folder
S warmpsd 20-07-2018 17:12 File folder
S Windows 02-01-2019 12:30 File folder
EYTR === N=Y 01 -06-2018 21:19 File folder
I | . Zebra-FXSeries-Embedded-SDK I 29-01-2019 16:50 File folder
—
EBTEC2CHSFEF 02-05-2018 06:46 File
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Navigate to Zebra-FXSeries-Embedded-SDK-> eclipse folder to verify that required files are available

as per following screenshot.

Figure 5 : Eclipse Folder

Windows (C:) » Zebra-FXSeries-Embedded-5DEK » eclipse »
= e— 0 oee— e e— o0 o e = = em  ee—

ay - Share with = Mew folder

Mame Date modified Type Size

. configuration 30-01-2019 20:21 File folder

\. dropins 20-06-2018 08:13 File folder

. features 30-01-201913:15 File folder

L op2 30-01-2019 20:22 File folder

. plugins 30-01-201913:15 File folder

. readme 30-01-201913:15 File folder
__| eclipseproduct 15-05-2018 10:07 ECLIPSEPRODUCT... 1KE
= artifacts.eml 26-01-2019 16:20 XML Document 307 KB
& eclipse.exe 20-06-2018 08:15 Application 415 KB
= | eclipse.ini 29-01-2019 11:26 Configuration sett... 1KBE
[m eclipsec.exe 20-06-2018 08:15 Application 127 KB

4.2 Setup System Variable — User Path
Set up system variable on the host machine.

The following screenshots will help in setting up the variable path.

Right Click on This PC (Windows 10) or Computer (Windows 7) and click on properties.

Figure 6 : System Properties

~ [ This PC

. 3D Objects Collapse
I Desktop ") Manage
Documents Pin to Start

‘r Downloads

J‘& Music Open in new window
[&=] Pictures Pin to Cuick access
B videos Disconnect network drive...

Map network drive...

ifm Local Disk

Add a network location

wm Local Disk ( Delete
=F Metwork Rename
Properties
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Click on Advanced properties

Figure 7 : Advanced System Settings

L4 Systemn

4 E 5 Control P

Control Panel Home

G Device Manager
G Remote settings
9 s

G Advanced systemn settings
e

Click on Environment Variables

Figure 8 : Environment Variables

System Properties x

Computer Name Hardware Advanced System Protection Remote

You must be logged on as an Administrator to make most of these changes.

Perfformance
Visual effects. processor scheduling. memory usage. and virtual memory

Settings...
User Profiles
Desktop settings related to your sign4in

Settings..
Startup and Recovery
System startup. system failure. and debugging information

Settings..

E Environment Variables... 1

OK Cancel Apply
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Click On New

Figure 9 : System Variable

Environment Variables

User variables for s.alam

Variable Value

OneDrive C:\Users\s.alam\OneDrive

Path C:\Users\s.alam\AppDatal\LocalMicrosoft\WindowsApps
TEMP C:\Users\s.alam\AppData\LocalN\Temp

TMP C:\Users\s.alam\AppDatalLocal\NTemp

New... Edit... Delete
< Systerm wvariables >
Variable Value 2
FXSERIES_EMBEDDED_SDK_... D:ANEW_ZIP\Zebra-FXSeries-Embedded-SDK
JAVA_HOME C:\Program Files\Java\jdk1.8.0_181
NUMBER_OF_PROCESSORS 4a
os Windows_NT
path C:\Program Files\Java\jre1.8.0_191
PATHEXT .COM.;.EXE;.BAT..CMD:;.VBS;.VBE;.JS; . JSE..WSF..WSH;:.MSC
PROCESSOR ARCHITECTURE AMDS4a >

e osiee

OK Cancel

Enter Variable name as “FXSERIES_EMBEDDED_SDK_WORKING_DIR”

Enter Variable value as the path of the extracted zip, for example

Variable value as “C:\Zebra-FXSeries-Embedded-SDK”

Note : There should not be any spaces in Variable name and Variable value fields.

Figure 10 : System Variable Pop up

New System Variable

Variable name: I FXSERIES_EMBEDDED_SDK_WORKING_DIR

Variable value: | C:\Zebra-FXSeries-Embedded-SDK|

Browse Directory... Browse File... Cancel

Next, click on OK for 3 times and close the system properties window.

ZEBRA TECHNOLOGIES

10



Y ZEBRA

STARTING SDK

5.0 Starting SDK

To start the SDK

Double click on the eclipse.exe file inside eclipse folder as mentioned in Figure 5.

Figure 11 : Eclipse Screen

eclipse ide

Photon

In the Workspace field, select the folder for project settings and project file storage.
For Ex: ‘[install-path]’\samples\java and click on select.

Click on Launch button. In the following example, the path has been set to “C:\ Zebra-FXSeries-

Embedded-SDK\samples\java” folder based on current installation path in the host.

Figure 12 : Workspace Popup

@] Eclipse Launcher X

Select a directory as workspace

Eclipse IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: l C:\Zebra-FXSeries-Embedded-SDK\samples\java v Browse...

[[JiUse this as the default and do not ask again:

» Recent Workspaces
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Close the welcome window if it appears.

Figure 13 : Eclipse Welcome Screen

File Edit Mavigate 5Search Project Run  Window Help
= ':g.\?.:_:' Welcome

i

Eclipse Java EE I

Note: The following instructions shows Microsoft Windows 10 Pro screens.

RFIDSampled4App can be found on the Package Explorer view.

Figure 14 : RFIDSample4App Package

File Edit Socurce Refactor Mavigate Search  Project |

i~ - 0-QL-Q-FEG-S®
{8 Package Explorer &3 %| ¢ ~ — O

=% RFIDSampledApp:

Note : If there is an exclamation sign against RFIDSample4App just like the following screenshot,
then there is a mismatch in API library. This can be rectified by removing the API3 jar, this has been
explained down in section 7.1.

5 java - Eclipse IDE

File Edit Source Refactor Mavigate Search Project

N B REICER SRRy R R

|03 RFIDSampledApp
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SETUP REMOTE CONNECTION FOR REMOTE DEBUGGING

6.0 Setup Remote Connection for Remote Debugging

The following steps describes how to setup a remote connection to a device in order to run a debug
session of the embedded application for JAVA or access a terminal session on the device to execute

the Linux commands or any applications.
On eclipse tool bar menu, please Select window-> perspective ->open perspective-> other

Figure 15 : Java Perspective

Window Help

b Mew Window Q ~ 8 &G~ - ¥ o ow oo
Editor 3
Appearance »
Show View >
Perspective > Open Perspective > ﬁfa Debug
=1 ;
Mavigation » Customize Perspective... L

Save Perspective As... g} STUTEET
Preferences

Reset Perspective... Other...

Close Perspective

Close All Perspectives

Select Remote System Explorer, Select open

Figure 16 : Package Explorer View

@3 Open Perspective O >

Ci}n Database Debug ~
({3 Database Development
%5 Debug

@y Git

a" Java

:G-;'Java Browsing

¢S java EE (default)
Tg"]ava Type Hierarchy
a&JavaScript

<+ JPA

@D Planning

<> Plug-in Development
EB Remote System Explorer
{5 Resource

&Y Team Synchronizing

& Web

X XMI N
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Select the remote system explorer button if available

Figure 17 : Remote System Explorer View

[Quick Acces] || = | v3 & €8

= 8 o= Outlinq Remote System Explorer i

An outline is not available.

Right click on Local in the remote system view and select new-> Connection.

Figure 18 : Connection View

File Edit Mawvigate Search Project Run Window Help

g - A r O~ U - @00 m N D
48 Remote Systems 53 | %5 Team = B
£ &1 | 2 | B|lw =
~ E¥ Local
‘ED Lo Mew > ¥  Connection...
E'* Lo Go Into
Go To >

Select Linux in the New Connection and click on Next.

Figure 19 : Remote System View
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r.-‘, New Connection

Any distribution of Linux

System type:
type filter text

Select Remote System Type I I

~ (= General
Cloud Foundry

Ty FTP Only

A Linux

Local

% SSH Only

% Telnet Only (Experimental)
unix Unix

&Y Windows

@ < Back Next > Finish Cancel

In the New Connection or Remote Linux System Connection,

In the Host field, enter the host (the device IP address or network name).
Connection name as ‘Test’, Description as ‘Demo’’ and select Next.

Note: Deselect Verify host name if the device is not accessible during setup.

Figure 20 : Remote Linux System Connection View
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@] MNew Connection O >

Remote Linux System Connection
Define connection infermation

Parent profile: Celsys050 -
Host name: | 192.168.7.95 ~|
Connection name: I Test I
Description: | Demo ]

I [] Verify host name I

nfigure pr setbings

@ < Back Mext > Finish

Cancel

Note: Display over parent profile may change. Still provide connection information.

In the New Connection or Files window, select ssh.files in the configuration section and select Next.
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Figure 21 : ssh Files View

@] New Connection (] >

Files

Define subsystem information

Configuration Properties
[] dstore.-files Property Value
[ ftp.files
A ssh.files

Available Services
22 Ssh / Sftp File Service
~ =4 SSH Connector Service
] SSH Settings

Description

Access a remote file system via Ssh / Sftp protocol

® [ < Back Next > FEinish [ Cancel

In the New Connection or Processes window select processes.shell.linux in the configuration section

and select Next.

Figure 22 : Process Shell Linux View

& New Connection O >

Processes

Define subsystem information

Configuration Properties
[] dstore.processes Property Value
] processes.shelllinux

Axailable Services
~=® Shell Process Service

Description

listing processes on the remote target through a contributed shell service

() [ < Back | TNext - [ Einish [ Cancel
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In the New Connection or Shells window select ssh.shells in the configuration section and Select

Finish.

Figure 23 : ssh shells View

@] New Connection O =<

Shells

Define subsystem information

Configuration Properties

[] idstore.shells: Property Value

EA1 ssh.shells

Available Services

22 Generic shell service
~ =4 SSH Connector Service

[ ] SSH Settings

Description

Work with shells and commands on remote systems using the Secure Shell (ssh) protocol.

@ < Boc N >

The new entry appears in the Remote System view.
Figure 24 : Test Connection View

E jawa - Eclipse IDE
File Edit Mavigate Search Project Run Window Help

=5 - KO- Qo P i®-iBin
48 Remote Systems 52 | %5 Team = O
&£ & | ¢l B|lS® ¥

~w Ef Local
> "a:, Local Files
T3 Local Shells
~ Test
» 'Oy Sftp Files
> Shell Processes
& Ssh Shells
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To connect to the device, Right click on the remote connection (Test) and select Connect.

Figure 25 : Test Connection Connect

=== s |
~ E Local
"E'D Local Files
% Local Shells
v M Test
'E'D g MNew
9 Go Into
= Go Te
E Cpen in Mew Window
EH Show in Table
=l Monitor
# 1 Refresh
I Rename...
W Delete...
[E Copy..
Mowve...
Export...
Import...
1F  Mowve Up
Mowve Down
] Propert

Connect

Tlaar Dacowsemrdc

F5

F2
Delete
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In the Enter Password window:

In the User ID field, Enter User ID as “rfidadm”
Leave the Password (optional ) field blank.

Select Save User ID and Save Password checkboxes.
Select OK.

Figure 26 : Password Popup View

i@ Enter Password X
System type: Linux
Host name: 192.168.7.95
Connection name:  Test
User ID: I fidadm ‘
Password (optional): I I
[ Save user ID
[] Save password

Note: Select Yes or OK for any warning messages regarding authentication and missing folders for

SSH Handling.

If Password Security Hint warning window appears, select No
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JAVA SAMPLE APPLICATION BUILD AND DEBUG

7.0 Java Sample Application Build and Debug

This section describes the build and debug steps for the RFIDSample4App which is given as part of
the zip package. This helps in understanding the steps and procedure to debug the given sample

application.

Note : If default perspective is not java in eclipse, then we can enable by 2 methods
Method 1:

Click on the following icon in eclipse.

Figure 27 : Java Perspective Icon

[Quick Access| || g8 @68

[E] Task List 3 ':'
Fr|lE | | Xk BE| 4
o

Method 2 :

Click on open perspective.

Figure 28 : Open Perspective Icon

(ot reee ] S0

—| ask List | Open Perspective l
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Select java and click Open.

Figure 29 : Java Selection View

@] Open Perspective O >

L“ﬁn Database Debug ~
({3 Database Development
%5 Debug
&y Git
83" Java
:'\-‘-;'Java Browsing
'ﬁ? Java EE (default)
Tg".lava Type Hierarchy
g:".lavaScript
< JPA
) Planning
0= Plug-in Develcpment
E8 Remote System Explorer
"5 Resource
5" Team Synchronizing
& Web
X Xmi ~
Use F2 to display the description for a selected perspective.

7.1 Import RFID3 APl Java Library to Embedded Java Project.

This section describes the steps on how to import RFID Symbol library for embedded java RFID

application.

Note : In case if the zip file was unzipped to “C:\” folder as mentioned in Figure 3 above and if there

is no exclamation mark on RFIDSample4App project, skip this 7.1 section.

In the Package Explorer view, Right click on the Project and select Properties.
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Figure 30 : RFID Sample Properties

@] Zebra - RFIDSampled New

File Edit Source R Go Into

il | & Open in New Window:
I Package Bxplarer 3% Open Type Hierarchy Fa
~ =2 RFIDSampledApg Show In AltShift-W

=i, JRE System Lil

~ @ sic
~ 3 org.zebra.f
31 RFIDSar

Copy Ctr+C
Copy Qualified Name

Paste Crrlew
Delete Delete

Remove from Context Ctrl+Alt+Shift+Down

Build Path
Source Al Shift+s
Refactor AltsShiftsT

=1 Import..
4 Export..
Build Project
& Refresh 5
Close Project
Close Unrelated Project
Assign Working Sets...
Coverage As
Run As
Debug As
Profile As

#0P

Fix Copyrights
Validate
Restore from Local History...
Team
Compare With
Configure

. RFIDSampledfpp

Properties Alt+Enter

>

= IDE
= g @ -ifiwmif - §l-xe - -
=2 = @
postStatusNotification(API_SUCCESS, null); ~m
fnyReader.Config.setTracelevel (TRACE_LEVEL . TRACE_LEVEL_ERROR); =
— B
=
ftch (InvalidUsageException ex) i
€ =
postStatusNotification(PARAM ERROR, ex.getVendorMessage()); =
ftch (OperationFailureException ex)
postStatusNotification(ex.getStatusDescription(), -
ex.getVendorMessage()); —
=
=]
Fn retvals =
ftatic void main(String[] =rgs) throws Interruptedexception { =
PO Auto-generated method stub =
SampleaApp rfidBase; =
Base — new RFIDSampleaApp()s =
=
=

Resource Path Location Type

Select Java Build Path. Click on Libraries Tab.

Note : If Symbol.RFID.API3.jar shows an error message saying missing or If Symbol.RFID.API3.jar is

not pointing to the selected workspace, then please remove it clicking Remove button, click on Add

External JARs and continue further.

Figure 31 : Java Build Path Selection

@] Properties for RFIDSampled4App
type filter text Java Build Path

Resource

Coverage

Java Build Path
Java Code Style
Java Compiler

Java Editor
Javadoc Location
Project Facets
Project Natures
Project References
Refactoring History
Run/Debug Settings
Server

Task Repository
Task Tags
Validation

WikiText

Builders &2 Source = Projects

Libraries

JARs and class folders on the build path:
=i, JRE System Library [JavaSE-1.8]

] >
<> - - -
<4 Order and Export
Add JARs...

f  AddExternal JARs... {

Add Variable...
Add Library...
Add Class Folder...

Add External Class Folder...

Edit...

Remove

Migrate JAR File...

Apply

Apply and Close Cancel
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In the Jar selection window, Browse UP/Back the folder to >>Zebra-FXSeries-Embedded-SDK,

then browse down to >>RFID_JAVA_API of the SDK Installation and select Symbol.RFID.API3.jar
Click Open.

Figure 32 : JAR Selection

8] JAR Selection

<« -~ 7~ << Zebra-FXSeries-Emb... > RFID_JAVA_API ~ & Search RFID_JAVA_API

Organize ~ New folder =2 - i |

= Name Date modified Type

<@ OneDrive

[ ] Symbol.RFID.API3.jar 30-11-2017 12:44 JAR File

8 This PC

8 3D Objects
Desktop
Documents
Downloads
Music
Pictures
Videos
Local Disk (C:)
Local Disk (D:)

b ERTY el

e . et =

File name: [ Symbol.RFID.APIZ jar ~]

Cancel

o

Click on Apply and Close.

Figure 33 : Java Build Path Select wiion

@ Properties for RFIDSampled4App )

type filter text

Resource

v

Builders

Coverage

Java Build Path
Java Code Style
Java Compiler

Java Editor
Javadoc Location
Project Facets
Project Natures
Project References
Refactoring History
Run/Debug Settings
Server

Task Repository
Task Tags
Validation

WikiText

VvV

v

Java Build Path

(*® Source => Projects =\ Libraries
JARs and class folders on the build path:

>

> = JRE System Library [JavaSE-1.8]

’3’{( Order and Export

oo Symbol.RFID.API3.jar - C:\Zebra-FXSeries-Embedded-SDK\RFID_JAVA

Add JARs...
Add External JARs...
Add Variable...
Add Library...
Add Class Folder...

Add External Class Folder...

Edit...

Remove

Migrate JAR File...

Apply

Apply and Close Cancel
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The Symbol.RFID.API3.jar class library appears in the Referenced Libraries section of the project

entry in package explorer view.

Figure 34 : Class Library View

E java - RFIDSampledfpp/src/org/zebra/RFIDSampledfpp/RFIC
File Edit Source Refactor Mavigate Search  Project

Hnil | @ BN O @
[ Package Explorer &3 %| e = - O

v =4 RFIDSampledApp

B\ JRE System Library [JavaSE-1.8]
=

Bl Referenced Libraries
oo Symbol.RFIDLAPIZ.ja

ora-FiSeries-Embedc

7.2 Building Java Executable Class File(s)
This section explains the steps on how to clean and build the RFIDSample4App java class.

Select the project name (RFIDSample4App) and go to Project menu item and select Clean.

Figure 35 : Project Clean View

E Zebra - RFIDSampledApp/src/org/zebra/RFIDSampledApp/RFIDSampledApp.java - Eclipse IDE
File Edit Source Refactor Mavigate Search  Project Run Window  Help

Y- |.uTq§’t$'6'Q‘@'§ Open Project
[ Package Explorer &3 = | ~ I Close Project
1= RFIDSampledApp |z Build All Ctrl+B
B JRE System Library [JavaSE-1.8] Build Project
v (2 src Build Working Set >
w f org.zebra.RFIDSampledipp Clean...
[7] RFIDSampledipp.java
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Note: Disable Start a build immediately checkbox.

Click on Clean button in Clean popup which appears after the above window.

Figure 36 : Project Clean Popup View

:._._-: Clean

projects will be rebuilt from scratch.
Clean all projects

Clean discards all build results and states. The next time a build occurs the selected

O x

=2 RFIDSampled4App

[] Start a build immediately
Build the entire workspace

Build only the selected projects

Clean Cancel

Select Project (RFIDSample4App) and go to project menu and select Build Project.

Figure 37 : Build Project View

E Zebra - RFIDSampledApp/src/org/zebra/REIDSampledApp/RFIDSampledApp.java - Eclipse IDE:
File Edit Source Refactor MNavigate Search | Project Run Window  Help

' ﬁ - | @ ' # - ﬁ - Q - q - '
[ Package Explorer 53 =) | e
v (=2 RFIDSampledipp |ozs
B\ JRE System Library [JavaSE-1.8]

w [ src

Open Project
Close Project

Build All Ctrl+B
Build Project
Build Warkinn Set ¥
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After build the results are shown in the Problems tab.

Figure 38 : Project Details Window View

|,"‘_ Problems 32 | @ Javadoc |'_{,=,:l, Declaration [ Console

0 errors, 17 warnings, 0 others
s

Description

5 Warnings (17 items)

7.3 Setup Java Remote Debug Configuration.
This section explains the steps on how to setup remote debug configuration for Zebra RFID readers

FX9600 or FX7500.

Class file built on windows host machine from eclipse will be transferred to the RFID reader.

7.3.1 Setup Java Remote Build Path.
The build path specifies the destination folder of the successfully build executable. Setting the build

path as a folder on the remote device ensures the executable is deployed on device as the last step

of a successful build.
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In the Package Explorer view, Right click on the project (RFIDSample4App) and select Properties to

open the project properties window.

Figure 39 : Project Details Window View

@] Zebra - RFIDSamples
File Edit Source R
Sl o ¢
|2 Package Explorer &
v 1= RFIDSample4Ap|

=\ JRESystem Li
v B src
~ i orgzebra.l 55

> 3) RFIDSar [T

Referenced Li 3¢

Symbol.RF

%

# 0P

. RFIDSampledApp
[rracacv s ance oo |

New
Go Into

Open in New Window
Open Type Hierarchy
Show In

Copy
Copy Qualified Name
Paste
Delete

Remove from Context
Build Path

Source

Refactor

Import...
Export...

Build Project
Refresh

Close Project

Close Unrelated Project
Assign Working Sets...

Coverage As
Run As

Debug As

Profile As

Fix Copyrights

Validate

Restore from Local History...
Team

Compare With

Configure

Properties

v

F4
Alt+Shift+W >

Ctrl+C

Ctrl+V

Delete

Ctrl+Alt+Shift+ Down
>
Alt+Shift+S >
Alt+Shift+T >

F5

Alt+Enter

ke IDE

o @~ BDiNif-Fl LoD
=

postInforiessage("Connected to " + hostName);
postStatusNotification(API_SUCCESS, null);
myReader.Config.setTraceLevel (TRACE_LEVEL.TRACE_LEVEL_ERROR);

Createmenu();
ftch (InvalidUsageException ex)

{
postStatusNotification(PARAM_ERROR, ex.getVendorMessage());
ftch (OperationFailureException ex)
postStatusNotification(ex.getStatusDescription(),
ex.getVendortessage());

rn retvalj;

ftatic void main(String[] args) throws InterruptedException {
DO Auto-generated method stub

Sample4App rfidBase;

Base = new RFIDSample4App();

hers
Resource Path Location
s)

Type

nn

Select Java Build Path and then select the Source tab, select project (RFIDSample4App/src).

Click on Browse to Folder Selection window.

Figure 40 : Browse bin File View

& Propertios for

type filter taxt

Resource
Bisilders
Coverage

lava Compiler
Java Editor

lavadoc Locat
Projpect Facets

Server

Task Tage
Validation
Wikl T

RFIDSampledApp

Jawva Build Path

= Projects m& Librames % Order and Export

Source Tolders on build path:
L RFIDSarmpledippd src

Java Build Path
lava Code Style

o

Project Matures
Project References
Refacroring History
Run/Debug Settings

Tazk Repositany

[ Allow output folders for sourge folders
Defaull output foldern

Agld Folder,.,

Link Source..

Edit...
Bemowve
EFIDSampledfppSbin | a:w..
apply
Apply and Clese Cancel

Select the Folder level in the which the remote folder is to be linked. (see below fig)
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Select Create New Folder to open the New Folder window.

Figure 41 : RFID Folder Selection View

Choose the folder for the build cutput:

@] Folder Selection O >

~ =2 RFIDSampled4App
> (= .settings
> = bin
> = META-INF
> = src

ECreate New Folder... !

@ OK Cancel

Select Advanced to expand the window to the advanced version.

Figure 42 : New Folder Popup View

i@} New Folder m] p 4

Folder name: |

@ OK Cancel
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Select Link to folder in the file system checkbox.
Select RSE in the choose file system drop down menu.
Select Browse to open the browse for file window.

Figure 43 : Browse Advanced View

@ Mew Folder O >

Eolder name:

<= Adwvanced

[=] Link to felder in the file system I

| E Browse... i Variables...
Choose file system: | RSE -

3 Folder name must be specified

® QK Cancel

Select the Connection (Test) in the Connection drop down menu, which was created in setting up a

remote connection for remote debugging as mentioned in section 6.

Expand My Home entry, select the directory on the device where the executable has to be created

and deployed as the final step of the build.
Select OK.

Figure 44 : RFID Sample Selection in Test Connection

) Browse For File s

Select a file
Connection: | Test = Flew...

fmintSdatasorgsrebra/RFIDSampledapp

o My Home
~ = org
e  zebra
1 RFIDSampledapp
TOEE
o Root

Cancel
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If org file is missing or Empty list appeared while connection to reader, follow the below steps.

Switch back to RSE perspective, expand Test and right click on My Home Directory, select New and

click on Folder.

8] java - RFIDSampledApp/sic/org/zebra/RFIDSampledApp/RFIDSampledApp.java - Eclipse IDE
Fle Edit Source Refactor Navigate Search Project Tools Run Window Help
e | & @il BRifg -0 -Q-iBO F-iF =
28 Remote Systems 17 |55 Team = O [ RFIDSampledAppjava 52
28| - | myReader. Events.addEventsListener (eventstandler);
v Ef Local It retval = true;
* Local Files 1 isConnected = true;

T Local Shells 1
v & demo 1
¥ Sftp Files 1
L= ] =
o Bl [ File
E
B ShellProces  Golnto [ o]

Ssh Shell:
T sshshells Sale > % Fiter..

postInfollessage("Connected to * + hosthame);
poststatusiotification(API_SUCCESS, null);

reatemenu();

ch (Invalid tion ex)

Tatch (OperationFailureException ex
postStatushotification(ex.getStatusDescription(),
ex.getVendorMessage());

Open in New Window

Show in Table

Monitor

Refresh F5

&
€]

return retVal;
Rename... F2

Delete... Delete

T

x0T

Copy.
imote System Details 53
Paste

Move...

Move Up

PPl | e D

Propertics Alt+Enter

Property Value "
Connection-private  No
Name My Home
Number of children 0

< 5

Create a new Folder

Enter New Folder Name as org and click on the Finish button.

myReader. Config.setTracelevel (TRACE_LEVEL.TRACE LEVEL ERROR);

oststatuslotification(PARAM ERROR, =x.getVendorMessage());

o5 X
B
= 8 g Outline 52
8 EBRW e W
Bl

# orgaebraRFIDSampledA A
v 3, RFIDSampledApp
myReader: RFIDF:
accessComplete : bot

inventoryComplste
accessEventLock: Lo
accessEventCondVar

o ooaoo B

inventoryStopEventL(
o inventoryStopCondVi
o % tagStore : Hashtables
&F API_SUCCESS: 5
&F PARAM_ERROR
& F APP_NAME : String

o isConnected: boolea

o hostMame: String

< >

v =g

ai

I8 Mew Folder O =
Remote Folder —
Create a Mew Folder . |
e
Connection name: | demao |
Parent folder: |,."'r'r1r1t."'data |
Mew folder name: | org| I |
":?:;' Cancel
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In the same way create zebra and RFIDSample4App folder i.e Right click on org folder, select New

and Click on Folder and enter New Folder Name as zebra and click Finish button.

Again Right click on the zebra folder, select New and click on the folder and enter New Folder Name

as RFIDSampled4App and click Finish button.
After this the folder structure should be appeared as per following screenshot.

B8] java - RFIDSampledApp/src/org/zebra/RFIDSampledfpp/RFIC
File Edit Scurce Refactoer MNavigate Search Project

ﬁ' |,u_Tq§@'§E§ ST
48 Remote Systems 52 | %5 Team = O
& & | ¢ |l BlR® <
w Ef Local
*y Local Files
=% Local Shells
wv ¥ demo

~ ¥, Sftp Files
g :‘=:=> My Home
~ [= org
~ (= zebra
[ RFIDSampledfipp

e moot
Shell Processes
% Sch Shells

In the New Folder popup, make sure folder name should be changed as shown in the below

screenshot and click OK.

Replace the character “?” with “_" (underscore) , otherwise it will throw error as “?” is not a valid

character.

Figure 45 : Folder Rename View

@ Mew Folder ] >

Folder namse: | RFIDSampledfpp Test

<< Adwvanced

Link to folder in the file system

| rsey /192,168,795 mnt/data/org/zebra, Browse... WVariables...
Choose file systern: | RSE e

ZEBRA TECHNOLOGIES 32



' ZEBRA

Make sure that the new folder (RFIDSample4App_Test) appears in the Folder Selection window and
select OK.

Figure 46 : Folder Selection View

i8] Folder Selection O =<

Choose the folder for the build cutput:

~ =2 RFIDSampled4App
> (= .settings
> = bin
> [ RFIDSampled4App_Test
> &= src

Create New Folder...

@ Concer

Select Apply and Close to complete the Java Build Setup

Figure 47 : Properties for RFIDSample4App View.

@] Properties for RFIDSample4App [} x

type filter text Java Build Path - T

> Resource .
Builders 2 Source = Projects =i\, Libraries <4 Order and Export

Coverage Source folders on build path:

JavaBuildBath > (*® RFIDSampled4App/src Add Folder...
Java Code Style

Java Compiler Link Source...
Java Editor

Javadoc Location Edit...
Project Facets

Project Natures Remove
Project References

Refactoring History

Run/Debug Settings

Server

Task Repository

Task Tags

Validation

WikiText

vVVvy

v

v

[] Allow output folders for source folders
Default output folder:

I RFIDSample4App/RFIDSampled4App_Test Browse...

Apply

® Apply and Close Cancel
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Select No to keep local build folder.

Figure 48 : Setting Build Path View

i@ Setting Build Paths

The output folder has changed. Do you want to remove the old location
‘RFIDSampled4App/bin’ and its content?

Yes

Cancel

7.4 Debug Embedded Java Application
This section explains detailed steps on debugging RFID sample application.

In the Package Explorer view, Right Click on the Project and click on Debug As -> Debug

Configuration.

Figure 49 : Debug Configuration View

@] zebra - RFIDSampl New »
File Edit Source Go Into
mif )

Open in New Window
Open Type Hierarchy F4
Alt+ Shift+W >

[% Package Explorer

v =7 RFIDSampledA Show In

> B JRE System| o,

v B sic B
v [# orgazebr: 5 Copy Qualified Name

E 0] RFIDS [ Paste —

v B Referenced 3¢ Delete Delete
s Symbol
& bin Remove from Context

Build Path
Source Alt+Shift+5 >
Refactor Alt+5Shift+T >

Copy Ctrl+C

Ctrl+Alt+Shift+Down

o

G- E

q Import...
Export...

Build Project
Refresh F3

G

Close Project
Close Unrelated Project
Assign Working Sets...

Coverage As b
Run As b
Debug As
Profile As

O

Fix Copyrights
Validate

pse IDE

@riEiNirE G

P RE
a i

postInfotlessage("Connected to " + hostName);
postStatushotification(API_SUCCESS, null);
myReader.Config. setTracelevel (TRACE_LEVEL.TRACE_LEVEL_ERROR);

Createmenu();
atch (InvalidUsageException ex)

postStatushotification(PARAM_ERROR, ex.getVendorMessage());

atch (OperationFailureException ex) {

postStatushotification(ex. getStatusDescription(),
ex.getvendorMessage());

urn retVal;

static void main(String[] args) throws InterruptedException {
TODO Auto-generated method stub

DSampledfpp rfidBase;

dBase = new RFIDSampledfpp();

hﬁ 1Debug en Server Alg+Shift+D, R

2 Java Application Alt+Shift+D, )

Debug Configurations...

h Locatien Tvpe
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In the Debug Configurations window, right click on Remote Java Application and then click on New

Configuration.

Figure 50 : Debug New Configuration View

@] Debug Configurations O =

Create, manage, and run configurations

Attach to a Java virtual machine accepting debug connections

@ ~0 | = Configure launch settings from this dialeg:
type filter text | | - Press the 'Mew Configuration’ button to create a configuration of the selected type.
E Apache Tomcat - @ - Press the 'Mew Prototype’ button to create a launch configuration prototype of the selected type.

& Eclipse Application
E4 Eclipse Data Tools
B Generic Server = - Press the 'Duplicate’ button to copy the selected configuration.
B Generic Server(Extern

B HTTP Preview
B J2EE Preview
E1 Java Applet

[T Java Application
Ju JUnit IL| - Select launch configuration(s) and then select 'Link Prototype' menu item to link a prototype.
30 JUnit Plug-in Test
L Launch Group
m2 Maven Build - Select launch configuration(s) and then select 'Res...ype Values' menu item to reset with prototype values.
nm Modejs Application
4 0S5Gi Framework

E Remote Java Applicat
% RemotelavaScript || MNew Configuration
Quﬂ Rhino lavaScript =
& Standalone VEVM

.4 - Press the 'Export’ button to export the selected configurations.

¥ - Press the 'Delete’ button to remove the selected configuration.

2 - Press the 'Filter' button to configure filtering options,

- Edit or view an existing configuration by selecting it.

u| - Select launch configuration(s) and then select "Unlink Prototype' menu itemn te unlink a prototype.

Configure launch perspective settings from the 'Perspectives' preference page.

MNew Prototype

& Export
Juy Task Context Test ot po.
@ WebKit Protocol Duplicate
= Delete

Filter matched 22 of 22 iter
L Link Prototype -

O u/  Unlink Prototype

Debug Close
R Reset with Prototype Values
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In the Host field, enter the host (the device IP address or network name).

In the Port field, enter the port available on the host system for remote debugging (for example

11001).

Make sure the above-mentioned port is not blocked by firewall.
Select the Allow Termination of remote VM checkbox.

Select Apply.

Select close to complete the remote configuration setup.

Figure 51 : Debug Configuration Properties View

E Debug Configurations

Create, manage, and run configurations
Attach to a Java virtual machine accepting debug connections

Y EAk:

type filber et

|| Hame: | RFIDSampledApp
5% Connect -t Source [ Commen |
4 Apache Tomcat ” Project:

& Eclipse Applicaticn T RFIDSampletApp

Ed Eclipse Data Tooks

8 Generic Server

4 Generic Server(Extern
8 HTTP Preview

B J2EE Preview

Connectjon Type:
Stanelard (Socket Attach)

— Conngction Properties

B Java Applet Host: | 192.168.6.58

T Java Application
Ju JUnit

Pog: | 11001

U Mnit Plug-in Test
. Launch Group
m2 Meven Build
M Nodejs Application
# 05Gi Framework
v [T Remote Java Applicat
T, RFIDSampleddpp
% Remote JavaScnpt
Rl Rhino JavaScript
& Standalone V3 VM
Jui Task Context Test ¥
L >

Filter matched 23 of 23 items

EA Allow termination of remote VM

@

Reyert Apply

Debug Close
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7.4.1 Remote SSH Terminal Setup
Open the Terminal view to access the device to start debug session and view application output.

Click on Terminal icon in the eclipse toolbar.

Figure 52 : Open Terminal View

®-|a|wip-Flmero-

| Open a Terminal (Ctri+Alt+5Shift+T) i

In the Launch Terminal window...

Select SSH Terminal from the Choose terminal drop down.

In the Host field, enter the host (the device IP address or network name).
For User field enter “rfidadm”.

For Password field, leave it blank.

Check Save user and Save password checkboxes.

Click on OK.

Figure 53 : SSH Terminal View

E Launch Terminal (| -

Choose terminall | 55H Terrminal o

Settings
Hosts: ~ |

Host: [192.168.6.58

User: | rfidadm

Password: |

Timeout (sec): | 0

KeepAlive (sec): | 300
Port: [22

LI L L L]

Encoding: Default (I50-8859-1) ~

Save user Save password

@ Cancel
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Terminal will open up as shown below

Figure 54 : Terminal View

v Problems @& Javadoc @ Declaration | /™ Terminal &3

&) 55H rfidadm@192.168.6.58 (31/1/19 12:43 PM) 52

Last login: Wed Jan 38 85:45:35 2819 from 192.168.6.143
rfidadmiFX968er2C1FE :~3%

Change the folder path

Command enter “cd org/zebra/RFIDSample4App” on the terminal to change the build path folder

Figure 55 : cd Command View

. Problems @ Javadoc @, Declaration @Terminal &3

) S5H rfidadm®192.168.6.58 (31/1/19 12:43 PM) 531

Last login: Wed Jan 38 85:45:35 2819 from 192.168.6.143
rfidadmiFX26@8F2C1FB:~% cd org/zebra/RFIDSampledipp/
rfidadmiFX2688F 2C1FB: ~/org/zebra/RFIDSampledipps

Execute the following command to start the debug session on device.

export LD_LIBRARY_PATH=/platform/lib/;java -agentlib:jdwp=transport=dt_socket,server=y,suspend=y,address=11001 -
Djava.library.path=/platform/lib/ -cp .:/platform/lib/Symbol.RFID.API3.jar org.zebra.RFIDSample4App.RFIDSample4App

Figure 56 : Export Command View

I#] Problems @ Javadoc @ Declaration | {8 Terminal 2 2 & | Iz G E@‘ )ﬂ = 8
] 55H didadm@192.168.6.58 (31/1/19 12:43 PM) 53

Last login: Wed Jan 3@ ©5:45:35 2019 from 192.165.6.143

rfidadmiFX96@@F2C1FE:~% cd org/zebra/RFIDSampledApp/

rfidadmi@FX96@@F2C1FE:~/org/zebra/RFIDSampledApps export LD_LIBRARY_PATH=/platform/lib/;java -agentlib:jdwp=transport=dt_socket,server=y,suspen

d=y,address=11881 -Djava.library.path=/platform/1ib/ -cp .:/platform/lib/Symbol.RFID.API3.jar org.zebra.RFIDSample4App.RFIDSample4App
Listening for transport dt_socket at address: 11881
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Start the debugging application in the eclipse environment
Click on the debug icon in the eclipse photon window.

Figure 57 : Open Debug View

Window Help
2init-]o-&-
tFIDSampledApp.

2A

Select Debug Configurations.

Figure 58 : Open Debug Configuration View

Window Help
Dt -Q - Q- QG-®E -
RFIDSample (no launch history)
534 Debug As 3
g:g Debug Configurations... on e
537 Organize Favorites... ARAN
538
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Select the created debug configuration and select Debug to start the remote application debugging.

Figure 59 : Create Manage Run Configuration View

@ Debug Configurations o >
Create, manage, and run configurations
Attach to a Java virtual maching sccepting debug connections
® ol X E Mame: | RFIDSamplediipp |
type filter best &7 Connect 1E Sowrce| [T] Common
8 Apache Tormcat - Project:
& Echpie Appliation [RFIDS 8
B Echpie Data Took Lo s I
Y Genenc Server Connection Type:
M Genenic Server([aterns
Standard (Socket Attach) b
B HTTP Preview = :
M EE Preview Connection Properties:
= Java Applet Hest: [ 192.168.7.95
[T lava Applecation |
N Fvik Por: [ 11001
B Winit Plug-mm Test B Aliow termination of rermvote VM

B Launch Geoup
md Maven Busld
- Mode s Sppl ation

f_Qso ek
. Rernote lava Applicati
T, RFIDSarmpletipp
P
%l Rhino lavaScript

G Standalone VE VI

Jiy Task Contest Test
< >
Paewert Apphy

Filter matched 23 of 25 wems

.

@ cioe

Click on Switch.

Figure 60 : Switch View

i@] Confirm Perspective Switch X

@ This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint

management.

Do you want to switch to this perspective now?

[JRemember my decision
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Note : By default breakpoint is enabled in the zip provided. Hence, please resume so that the RFID

application comes out of the breakpoint.

Click on Resume icon as shown below.
Figure 61 : Resume Manage View

Run  Window Help
e | 0|00 @ &S

0 Y Resume 9 pi

TR
RN

Note : On Photon eclipse , remote system explorer does not support SSH terminal. Hence, we need

to switch to Java perspective to visualise the output of RFID application on terminal window.

Select java Perspective on the eclipse window as shown below.

Figure 62 : Java Perspective View

HEIEE: 1T
Expressions

g=sB v
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The application runs and displays the terminal output in the terminal view.

Figure 63 : Terminal Output View

8 Terminal &3

&) 55H rfidadm@192.168.6.58 (31/1/19 12:43 PM) 52

Listening for transport dt_socket at address: 11e8l
Connected to 127.8.8.1
Status: Function Succeeded Vendor Message: null

----Command Menu----
Capability
Configuration
Inventary

Access

Exit

(¥ N S WY S

Note : Changing Reader IP
In case if user wants to change the reader IP, please follow the below steps

Step 1: Under Section 6, goto Figure 25, right click Test connection -> Click on Disconnect -> right
click on Test Connection -> Click on Properties -> Click on Host -> In the Host name dropdown enter
the new IP which user wants to change to.

Step 2 : Select Verify Host Name checkbox -> Click on Apply and Close

Step 3 : Follow Section “7.4 Debug Embedded Java Application” again , follow Figure 51 : Debug

Configuration Properties View, change the IP which user wants to change to.

Step 4 : Follow Section “7.4.1 Remote SSH Terminal Setup” again, follow Figure 53 : SSH Terminal

View, change the IP which user wants to change to.
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EMBEDDED JAVA APPLICATION

8.0 Embedded Java Application

This section describes the detailed steps to create embedded Java RFIDSampled4App from scratch.

The steps involved are

e (Create Project

® Add sources

e Import RFID system library

e (Clean and build steps

e Setting up of Java remote debug config
e Set up Remote build path

e Debug embedded java RFID application
e C(Creation of Jar executable

e Creation of start and stop script for java installation package

8.1 Creating an Embedded Java Project
Note : If Remote connection for debugging is not created,

Please refer section 6.0 for remote connection steps

Note: If default perspective is not java in eclipse, then we can enable it in 2 methods.

Please refer section 7.0 of enabling Java perspective.

Once done with above mentioned step, please create a new Java project as mentioned below.
Select File->New->Java Project

Figure 64 : Java Eclipse IDE View

E java - Eclipse IDE
File Edit 5Source Refactor MNavigate Search Project Tools Bun Window Help
Mew Alt+Shift+M > |20 Java Project
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In the New Java Project/Create a Java Project window, enter the Project name “RFIDSample4App”

and select Finish.

Figure 65 : Create Java Project View

] rdews Java Project - =
Create a Java Project 5, I
Create a Java project in the workspace or in an external location, |./ -
I Praject narme: | RFIDSarmpleddpp| I |
=] Use default locaticon
DA MEW_FIPZFebra-FRSeries- Embedded-SDEysarmples) jawat, Browse...
JRE
Use an execution emvironment JRE: JavaSE-1.8
Use a praject specific JRE: jrel1.8.0_191
Use default JRE (currenthy jrel S.0_191") Configure IREs,.,

Project layout
Use praject folder as ract for sources and class files

Create separate folders for sources and class files Configure default..,

Waorking sets
[ add project to working sets P, ..

Select...

i3 The wizard will autormatically configure the JRE and the project layout based on the
existing source,

@ - Back Pt - Cancer

The new project appears in the Package Explorer section.

Figure 66 : RFID Sample View

E jawa - Eclipse IDE
File Edit Sowurce Refactor MNavigate Search Project

B s - Biwmids- 0~ G- Q-
[# Package Explorar i3 %l =5 = = O
» == RFIDSampledApp

ZEBRA TECHNOLOGIES

44



' ZEBRA

8.2 Adding Source File to Embedded Java Project
In the package explorer view, expand the project, right-click on src, and select New-> Class.

Figure 67 : Create Class View

E java - Eclipse IDE
File Edit Source Refactor MNavigate Search Project Tools Bun  Window Help

H-AREB- 8w - 0- Q- Q- HF G- ®™C &~~~

[ Package Explorer 53 S, | ¢ = 0O
v &> RFIDS Mew » ﬁ Java Project
. ; Js}::[ Open in Mew Window ] Project..
Open Type Hierarchy F4 H¥ Package
Show In Alt+Shift+W > | (& Class

In the New Java Class Window, enter the Package “org.zebra.RFIDSample4App” and Name

“RFIDSampledApp”.
Select Finish.

Figure 68 : Create Class View

Mlew Java Class = -4
Java Class —

Create a new Java class. @
Source folder: | RFIDSarmpledapp/sre Browse...
IFachagﬂ | org.zebra.RFIDSampledipp | I Browse..
[] Enclesing type: Browse...
Marme: | RFIDSampledipp]| |

FAodifiers: = public ) pagkage priyate protected

[] abstract [_]final static

Superclass: |__ia'\._rc_|.lc_|_r19.D_b_il:_ct_ ] Browsg..
Interfaces: add...

Eemowe

Which method stubs would you like to create?
[] public static yoid main(String[] args)
[ Canstructars from superclass
Inherited abstract methods
Da you want te add comments? (Configure termplates and default value here)
[ Generate camments

@
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The source file appears in the window.
Figure 69 : RFID Package View

ﬂ java - RFIDSampledApp/src/org/zebra/RFIDSampledApp/RFIDSampledApp.java - Eclipse IDE
File Edit 5Source Refactor Mavigate 5Search Project Tocls Run Window Help
e | @ @~ BiNiF-0- Q- QU W G- OO V- P I RE
[# Package Explorer 53 =N | ¢ =~ — O [J] RFIDSampledfpp.java 532
v =2 RFIDSampledfpp
B\ JRE System Library [JavaSE-1.8]
w B cre

~ f org.zebra.RFIDSampledipp
RFIDSampledApp.java

backage org.zebra.RFIDSampledipp;

public class RFIDSampled4App {

}

O W s b R

Copy the java source code from “RFIDSampled4App.java” file which is part of the java sample folder

at “Zebra-FXSeries-Embedded-SDK\samples\java\RFIDSample4App\src\org\zebra\RFIDSample4App”
Overwrite the file with contents of file which was copied above.

Figure 70 : RFID Code View

E java - RFIDSampledApp/src/org/zebra/RFIDSampledApp/RFIDSampledApp java - Eclipse IDE

File Edit Source Refactor Navigate Search Project Toole Run  Window Help

MR B @ -Binit -0 - Q- G-I PHeRFE T H GO D

[# Package Explorer 51 [S=N ‘ @ ¥ = B | [J *RFIDSampledAppjava 32 =

~ = RFIDSample4App 1 package org.zebra.RFIDSampledApp;
=, JRE System Library [JavaSE-1.2] 2

> |81

0 000 0 K0 N -

2
v sre 32 import gcom.mof.rfid.api3.*;
g import gom.mot.rfid.api3.PreFilters.PreFilter;
~ B org.zebra RFIDSampledApp import java.io.BufferedReader;

4
5
RFIDSampledApp.java 6 import java.io.IOException;
7
8
9

&'k

import java.io.InputStreamReader;
import java.util.Hashtable;
import java.util.InputMismatchException;
1% import java.util.concurrent.locks.*;
11 import java.util.Calendar;

13 public class RFIDSampledApp {
& 14 REIDReader myReader = null;
15 private boolean accessComplete = false;
16 private boolean inventoryComplete = false;

I00mm o

18 private Lock accessEventlock = new ReentrantLock();
19 private Condition accessEventCondVar = accessEventleck.newCondition();

21 private Lock inventoryStopEventlock = new ReentrantLock();
22 private Condition inventoryStopCondvar = inventoryStopEventlock.newCondition();

24 public static Hashtable<String,Long> tagStore = null;

26 public static final String API SUCCESS = "Function Succeeded”;
27 public static final String PARAM ERROR = "Parameter Error”;
r: -

- 221 faofoo annomas " ArTACo—eToa. w

1 1
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Add the break point and Save the file.

Note : Add the breakpoint by double clicking the respective line number.

Figure 71 : RFID Breakpoint View

1547
15485
F=1549

58
@1351

8.3

public static woid main(String[] args) throws InterruptedException {
// TODO Auto-generated method stub
RFIDSampled4App rfidBase;

new RFIDSampledipp();

rfidBase

Import RFID3 APl Java Library to Embedded Java Project.

This section describes the steps on how to import RFID Symbol library for embedded java RFID

application.

In the Package Explorer view, Right click on the Project and select Properties.

Figure 72 : RFID Sample Properties

@] Zebra - RFIDSampled
File Edit Source Ri

B = B
[# Package Explorer &

~ =2 RFIDSampledApg
=i JRE System Lil
~ (@ sic

~ 8 orgaebraf 5=

[3] RFIDSar

. RFIDSampledfpp

[E]

[Ie}
x

#OP

Mew

Go Into

Open in Mew Window
Open Type Hierarchy

Show In

Copy
Copy Qualified Name
Paste

Delete

Remove from Context
Build Path
Source

Refactor

Import...
Export.

Build Project

Refresh

Close Project

Close Unrelated Project
Assign Working Sets...

Coverage As
Run As

Debug As

Profile As

Fix Copyrights

Validate

Restore from Local History...
Team

Compare With

Configure

Propertics

F4
Alt+ Shift+W >

Ctrl+C

Ctrl+V
Delete

Ctrl+Alt+Shift+Down
>
Alt+Shift+5 >
Alt+Shift+T >

Alt+Enter

e IDE

@~
22

Createmenu();

Pn retval;

Samplesspp rfidBase;

=R

e

tch (InvalidUsageException ex)

Base = new RFIDSampleddpp();

Resource

-0 oo

postStatusNotification(API SUCCESS, null);
myReader.Config.setTraceLevel (TRACE LEVEL.TRACE_LEVEL ERROR);

Path

{
postStatusNotification(PARAM_ERROR, ex.getVendortessage()):
tch (OperationFailursException ex)
poststatusNotification(ex.getStatusDescription(),
ex.getVendortessage());

tatic void main(String[] args) throws InterruptedException {
DO Auto-generated method stul

Location Type

24

0 0000 O OOmm =

00DDOD0OoD OO0 0 DOMOM @
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Select Java Build Path. Click on Libraries Tab. Select Add External Jars

Figure 73 : Java Build Path Selection

@ Properties for RFIDSampled4App

type filter text

> Resource

Builders

Coverage

Java Build Path
Java Code Style
Java Compiler

Java Editor
Javadoc Location
Project Facets
Project Natures
Project References
Refactoring History
Run/Debug Settings
Server

Task Repository
Task Tags
Validation

WikiText

vVVvy

v

v

@

Java Build Path

(*® Source U= Projects =\ Libraries
JARs and class folders on the build path:

> =4 JRE System Library [JavaSE-1.8]

% Order and Export

[} x
= - -
Add JARs...
[ AddExternal JARs... |
Add Variable...
Add Library...

Add Class Folder...

Add External Class Folder...

Edit...

Remove

Migrate JAR File...

Apply

Apply and Close Cancel

In the Jar selection window, Browse In the folder, RFID_JAVA_API of the SDK Installation and select

Symbol.RFID.API3.jar
Click Open.

Figure 74 : JAR Selection

@] JAR Selection

- -

Organize ¥

~
<@ OneDrive

8 This PC
8 3D Objects
B Desktop
] Documents
3 Downloads
D Music
[&=] Pictures
B Videos
‘ies Local Disk (C:)
wss Local Disk (D:)

Y &

<< Zebra-FXSeries-Emb... >

New folder

File name:

RFID_JAVA_API

~
Name

| ] Symbol.RFID.API3.jar

v <

~

o

Search RFID_JAVA_API o
>~ @ @

Type

Date modified

30-11-2017 12:44 JAR File

Symbol.RFID.API3. jar

~ | *jar;*.zip e

Cancel
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Click on Apply and Close.

Figure 75 : Java Build Path Selection

@] Properties for RFIDSample4App a x
type filter text Java Build Path LI 4 v w
Resource . ~
Builders (*® Source = Projects = Libraries <4 Order and Export
Coverage JARs and class folders on the build path:
davalBuild P"'I" . os Symbol.RFID.API3 jar - C:\Zebra-FXSeries-Embedded-SDK\RFID_JAVA Add JARs...
Java Code Sty e » = JRE System Library [JavaSE-1.8]
Java Compiler Add External JARs...
Java Editor
Javadoc Location Add Variable...
Project Facets =
Project Natures LG L
Project References Add Class Folder...
Refactoring History
Run/Debug Settings Add External Class Folder...
Server
Task Repository Edit...
Task Tags
Validation Remove
WikiText
Migrate JAR File...
< >
Apply
@ Apply and Close Cancel

The Symbol.RFID.API3.jar class library appears in the Referenced Libraries section of the project

entry in package explorer view.
Figure 76 : Class Library View

E java - RFIDSampledfpp/src/org/zebra/REIDSampledApp/RFIC
File Edit Source Refactor MNavigate Search Project

Hmi | @~ B it QG-
[ Package Explorer &3 %| & ~ — O

v =% RFIDSampledApp
B\ JRE System Library [JavaSE-1.8]
=

B, Referenced Libraries
jwa Symbol RFID.API3.jap - et

8.4  Building Java Executable Class File(s)
This section explains the steps on how to clean and build the RFIDSample4App java class.

ra-F¥5eries-Embedc
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Select the project name (RFIDSample4App) and go to Project menu item and select Clean.

Figure 77 : Project Clean View

E Zebra - RFIDSampledApp/src/org/zebra/RFIDSampledApp/RFIDSampledApp.java - Eclipse IDE

File Edit Source Refactor Mavigate

[ Package Explorer &3
~ (=% RFIDSampledipp

B JRE System Library [JavaSE-1.8]

w [ src

w f org.zebra.RFIDSampledipp
[7] RFIDSampledipp.java

Search  Project  Run
Iﬁv |@I¢707QTQvI

E%l|s

=

Open Project
Close Project

|y Build All
Build Project
Build Working 5et
Clean...

Window Help

Ctrl+B

Click on Clean button in Clean popup which appears after the above window.

Note: Disable Start a build immediately checkbox.

Figure 78 : Project Clean Popup View

::.] Clean

O

Clean discards all build results and states. The next time a build occurs the selected

projects will be rebuilt from scratch.

Clean all projects

=2 RFIDSampled4App

[[] Start a build immediately
Build the entire workspace

Build only the selected projects

Clean Cancel
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Select Project (RFIDSample4App) and go to project menu and select Build Project.
Figure 79 : Build Project View

ﬂ Zebra - RFIDSampledApp/src/org/zebra/RFIDSampledApp/RFIDSampledApp.java - Eclipse IDE:
File Edit Source Refactor Mavigate Search  Project Run Window Help

i |Iu'ﬁ§:§5;vaqu%vg Open Project
o Close Project
[ Package Explorer i3 B % | ¢ :
V'[.’_'—‘/J' RFIDSampledApp |y Build All Ctrl+B
B\ JRE System Library [JavaSE-1.2] Build Project
v [ src Ruild Warkina Set >

After build the results are shown in the Problems tab.

Figure 80 : Project Details Window View

[#] Problems i3 | @ Javadoc [, Declaration & Console

0 errors, 17 warnings, 0 others
s

Description

5 Warnings (17 items)

8.5 Setup Java Remote Debug Configuration.
This section explains the steps on how to setup remote debug configuration for Zebra RFID readers

FX9600 or FX7500.

Class file built on windows host machine from eclipse will be transferred to the RFID reader.

8.5.1 Setup Java Remote Build Path.
The build path specifies the destination folder of the successfully build executable. Setting the build

path as a folder on the remote device ensures the executable is deployed on device as the last step

of a successful build.
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In the Package Explorer view, Right click on the project (RFIDSample4App) and select Properties to

open the project properties window.

Figure 81 : Project Details Window View

@] Zebra - RFIDSample« =
File Edit Source R Go Into

— I fnd Open in New Window

% Package Explorer 3 Open Type Hierarchy F4
~ =2 RFIDSampledAp| Show In Alt+Shift+W >
= JRE System Li -

~ 5B src -
- & org.zebral Copy Qualified Name

[3) RFIDSar Paste Ctri+v

~ =i ReferencedLi 3¢ Delete Delete
(e Symbol.RF

Copy CtrlsC

Remove from Context Shift+Down
Build Path >
Source Alt+Shift+S >

Refactor Alt+Shift+T >

Import...

Export...

Build Project

& Refresh Fs
Close Project

Close Unrelated Project

Assign Working Sets...

Coverage As >
Run As >
Debug As >
Profile As >

#OP

Fix Copyrights
Validate
Restore from Local History...
Team >
Compare With >
< Configure >

RFIDSa: ledA
o chilnaednild Properties Alt+Enter
e e

Select Java Build Path and then select the Source tab, select project (RFIDSample4App/src).

se IDE

& @-iBDiw ~Fl- oD

lpostInfotiessage("Connected to " + hostName);
postStatusNotification(API_SUCCESS, null);
myReader.Config.setTraceLevel (TRACE_LEVEL.TRACE_LEVEL_ERROR);

Createmenu();
ftch (InvalidUsageException ex)

postStatusNotification(PARAM ERROR, ex.getVendorMessage());

ftch (OperationFailureException ex) {

postStatusNotification(ex.getStatusDescription(),
ex.getVendorMessage());

rn retval;

ttatic void main(String[] args) throws InterruptedException {
k Auto-generated method stub

iSample4App rfidBase;

[Base = new RFIDSampled4App();

hers
Resource Path Location

Type

nn

Click on Browse to Folder Selection window.

Figure 82 : Browse bin File View
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@] Properties for RFIDSampled4App (]
type filter text Java Build Path = =
> Resource
Builders (2 Source == Projects =i Libraries % Order and Export
Coverage Source folders on build path:

Java Build Path

> Java Code Style > (2 RFIDSampled4App/src Add Folder...
> Java Compiler Link Source...
> Java Editor

Javadoc Location Edit...

Project Facets

Project Natures Remove

Project References
Refactoring History
Run/Debug Settings

Server
> Task Repository
Task Tags
> Validation
WikiText
[ Allow output folders for source folders
Default cutput folder:
I RFIDSample4App/bin I ‘ Browse...
Apply
@ Apply and Close Cancel

Select the Folder level in the which the remote folder is to be linked. (see below fig)
Select Create New Folder to open the New Folder window.

Figure 83 : RFID Folder Selection View

::.] Folder Selection O x

Choose the folder for the build output:

v =2 RFIDSample4App
> (= .settings
> = bin
> = META-INF
> & src

[Create New Folder... !

@ OK Cancel
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Select Advanced to expand the window to the advanced version.

Figure 84 : New Folder Popup View

@] New Folder O X

Folder name: l

@ OK Cancel

Select Link to folder in the file system checkbox.
Select RSE in the choose file system drop down menu.

Select Browse to open the browse for file window.

Figure 85 : Browse Advanced View

ZEBRA TECHNOLOGIES

54



' ZEBRA

i@} New Folder O *

Eolder name: |

<< Advanced

[V]Link te folder in the file system

| Browse.., I Variables...

Choose file system: | RSE v

£ Folder name must be specified

?) oK

Cancel

Select the Connection (Test) in the Connection drop down menu, which was created in setting up a

remote connection for remote debugging as mentioned in section 6.

Expand My Home entry, select the directory on the device where the executable has to be created

and deployed as the final step of the build.

If Org folder is missing , please refer to page 29 under Setup Java Remote Build Path.
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Select OK.

Figure 86 : RFID Sample Selection in Test Connection

[ Browwse For File

Select a file

frntSdatasorglrebrasREIDSarmpledapp

— e My Home
~ = org
~— = zebrs
) RFIDSampledapp

o oEr
He Root

Cancer

Connection: | Test — Pl

Note : In case of if Enter Password window pops up, enter the User ID as “rfidadm”,

In password field, leave it blank.
Enable Save Password and Save user ID check boxes.

Figure 87 : Password Popup View

'i"i. Enter Password P
Systerm type: Lirwe
Heost name: 192.168.7.95
Connection name: Test
User ID: | [ rfidadm |

Password (optional): | |
Sawve user D
Sawve passwword

I Lol - I Cancel

In the New Folder popup, make sure folder name should be changed as shown in the below

screenshot and click OK.
Replace the character “?” with “_" (underscore)

Figure 88 : Folder Rename View
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I8 Mew Folder O =

Folder name: | RFIDSampledApp Test

<= Adwvanced

Link to folder in the file system

| rse://192.168.7.95/mnt/data/org/zebra, Browse... Variables...

Choose file system: | RSE -

@

Make sure that the new folder (RFIDSample4App_Test) appears in the Folder Selection window and

select OK.

Figure 89 : Folder Selection View

8] Folder Selection O >

Choose the folder for the build cutput:

~ == RFIDSampled4App

> .settings
bin
RFIDSampled4App_Test
src

PROD

Create New Folder...

@ Cancet

Select Apply and Close to complete the Java Build Setup

Figure 90 : Properties for RFIDSample4App View.
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@] Properties for RFIDSampledApp (]

type filter text Java Build Path Y

> Resource
Builders 2 Source = Projects =i\, Libraries <4 Order and Export

Coverage Source folders on build path:

davalBruidiiathy > (% RFIDSample4App/src Add Folder...
Java Code Style —
Java Compiler Link Source...
Java Editor
Javadoc Location Edit...
Project Facets - -
Project Natures Remove
Project References ‘
Refactoring History
Run/Debug Settings
Server

Task Repository
Task Tags

Validation

WikiText

vVvy

v

v

[J Allow output folders for source folders
Default output folder:

I RFIDSampled4App/RFIDSampledApp_Test Browse...

Apply

® Apply and Close [ Cancel

Select No to keep local build folder.

Figure 91 : Setting Build Path View

i@] Setting Build Paths X

The output folder has changed. Do you want to remove the old location
‘RFIDSampledApp/bin' and its content?
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8.6  Debug Embedded Java Application
This section explains detailed steps on debugging RFID sample application.

In the Package Explorer view, Right Click on the Project and click on Debug As -> Debug

Configuration.

Figure 92 : Debug Configuration View

&) 7ebra-RFDSampl New s jpselDE
File Edit Source Go Into
O |"'-_W Open in New Window C E " RAN=ER RRUR S TR A CRER AR
[ Package Explorer Open Type Hierarchy F4 a 22
v'_":‘l RFIDSampledA Show In Alt+Shift\W > | postInfolessage("Connected to " + hosthame);
=, JRESystem | postStatushotification(API_SUCCESS, null);
= B Copy CtC | myReader.Config.setTracelevel(TRACE_LEVEL. TRACE LEVEL ERROR):
il
= B2 Copy Qualified Name
"I‘B org.zebri = B Createmenu();
AT RFIDS [[§ Paste Ctrl+V
v B Referenced 3¢ Delete Delete fatch (InvalidUsageException ex)
o Symball
. Remove from Context Ctrl+Alt+Shift+Down postStatushotification(PARAM ERROR, ex.getVendorMessage());
& bin h (OperationFailureExceptio
Build Path 5 atch (OperationFailureException ex) {
U postStatushotification(ex.getStatusDescription(),
Source Alt+Shift+5 > ex.getvendortessage());
Refactor Alt+Shift+T >
N
g Import urn retval;
g Export.
Build Project
% Refresh 5 |static void main(String[] args) throws InterruptedException {
o . TODO Auto-generated method stub
Close Project DSampledfpp rfidBase;
Close Unrelated Project dBase = new RFIDSample4App();
Assign Working Sets..,
Q Coverage As b
D Runks b
45 Debug As > 8 1Debug on Server Alt+Shift+D, R
Profile As > I 2lava Application Alt+Shift+D, |
Lo Debug Configurations...
Validate h Location Tvpe
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In the Debug Configurations window, right click on Remote Java Application and then click on New

Configuration.

Figure 93 : Debug New Configuration View

ﬂ Debug Configurations

Create, manage, and run configurations

Attach to a Java virtual machine accepting debug connections

[ & | =
type filter text

E Apache Tomcat

& Eclipse Application
E4 Eclipse Data Tools

B Generic Server

B Generic Server(Extern
B HTTP Preview

B J2EE Preview

E1 Java Applet

[T Java Application

Ju JUnit

30 JUnit Plug-in Test

L Launch Group

m2 Maven Build

nm Modejs Application
4 0S5Gi Framework

E Remote Java Applicat
“%» Remote JavaScript
Quﬂ Rhino lavaScript

& Standalene V28 VM

Juy Task Context Test

& WebKit Protocol
<

Filter matched 22 of 22 iter

e
@

Configure launch settings from this dialog:
| - Press the 'Mew Cenfiguration’ button to create a configuration of the selected type.

@ - Press the 'Mew Prototype’ button to create a launch configuration prototype of the selected type.
.4 - Press the 'Export’ button to export the selected configurations.

“=| - Press the 'Duplicate’ butten to copy the selected configuration.

¥ - Press the 'Delete’ button to remove the selected configuration.

"5 - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.
IL| - Select launch configuration(s) and then select 'Link Prototype' menu item to link a prototype.
u| - Select launch configuration(s) and then select "Unlink Prototype' menu itemn te unlink a prototype.

- Select launch configuration(s) and then select 'Res...ype Values' menu item to reset with prototype values.

Configure launch perspective settings from the 'Perspectives' preference page.

Mew Configuration
MNew Prototype
Export

Duplicate

Delete

Link Prototype -

Unlink Prototype
Debug Close

Reset with Prototype Values

In the Host field, enter the host (the device IP address or network name).
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In the Port field, enter the port available on the host system for remote debugging (for example

11001).

Make sure the above-mentioned port is not blocked by firewall.

Select the Allow Termination of remote VM checkbox.
Select Apply.
Select close to complete the remote configuration setup.

Figure 94 : Debug Configuration Properties View

E Debug Configurations

Create, manage, and run configurations
Attach to a Java virtual machine accepting debug connections

O F @ B %5 || ame [RFDSampletapp
type filter bext 5¥ Connect -t Source| [ Commen |
4 Apache Tomcat - Project:

& Eclipse Applicaticn - RFIDSampledApp

Ed Eclipse Data Toolks

B Generic Server Connection Type:

g :‘T":P"; ch s Standard (Socket Attach)
In TEVIEW
"j J2EE Preview Conngction nmprrtir-:

B Java Applet Host: | 192.168.6.58

T Java Application
Ju MUnit

Pogt: | 11001

J MUnit Plug-in Test
i Launch Group
m2 Maven Build
i Medejs Spplication
# 05Gi Framework
w [0 Remote Java Applicat
T, RFIDSampleddpp
% Remote lavaScript
Rl Rhino JavaScript
& Standalone V3 VM
Jui Task Context Test ¥
< >

Filter matched 23 of 23 items

E4] Allow termination of remote VM

@

Reyert Apply

Debug Cloge
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8.6.1 Remote SSH Terminal Setup
Open the Terminal view to access the device to start debug session and view application output.

Click on Terminal icon in the eclipse toolbar.
Figure 95 : Open Terminal View

@®-[B]|wit -5~

[ ©pen a Terminal (Ctrl+Alt+Shift~T) |

In the Launch Terminal window...

Select SSH Terminal from the Choose terminal drop down.

In the Host field, enter the host (the device IP address or network name).
For User field enter “rfidadm”.

For Password field, leave it blank.

Check Save user and Save password checkboxes.

Click on OK.

Figure 96 : SSH Terminal View

E Launch Terminal (| =
Choose terrminall | 55H Terrminal o
Settings
Hosts: bt b4
Host: [ 192.168.6.58
User: | rfidadm

Password: |

Timeout (sech: | o]

KeepAlive (sec) | 300
Port: [22

N | N | W - - -

Encoding: | Default (I50-28859-1) e

Save user Save password |

(2:' I Ok I Cancel

Terminal will open up as shown below
ZEBRA TECHNOLOGIES



Y ZEBRA

Figure 97 : Terminal View

|"_ Problems @ Javadoc @, Declaration {!'Terminal =

& 55H rfidadm@192.168.6.58 (31/1/19 12:43 PM) 52
Last login: Wed Jan 3@ 85:45:35 2819 from 192.168.6.143
rfidadm@FX9688F 2C1FB :~%

Change the folder path

Command enter “cd org/zebra/RFIDSample4App” on the terminal to change the build path folder

Figure 98 : cd Command View

|"_ Problems @@ Javadoc @, Declaration @Terminal &3

) S5H rfidadm®192.168.6.58 (31/1/19 12:43 PM) 52

Last login: Wed Jan 38 85:45:35 20819 from 192.168.6.143
rfidadmiFX9688F2C1FB:~% cd org/zebra/RFIDSampledfpp/
rfidadmiFX96@88F2C1FB:~/org/zebra/RFIDSampledfppt

Execute the following command to start the debug session on device.

export LD_LIBRARY_PATH=/platform/lib/;java -agentlib:jdwp=transport=dt_socket,server=y,suspend=y,address=11001 -
Djava.library.path=/platform/lib/ -cp .:/platform/lib/Symbol.RFID.API3.jar org.zebra.RFIDSample4App.RFIDSample4App

Figure 99 : Export Command View

2] Problems @ Javadoc |2, Declaration | 8 Terminal 13 B2 it | I5 G BE| & =0
&) 55H rfidadm@192.168.6.58 (31/1/19 1243 PM) 3
Last login: Wed Jan 3@ 85:45:35 20819 from 192.168.6.143

rfidadm@FX968@F2C1FB:~$ cd org/zebra/RFIDSample4App/
rfidadm@FX96@@F2C1FE: ~/org/zebra/RFIDSampledfpp$ export LD_LIBRARY_PATH=/platform/lib/;java -agentlib:jdwp=transport=dt_socket,server=y,suspen

d=y,address=11881 -Djava.library.path=/platform/1ib/ -cp .:/platform/lib/Symbol.RFID.API3.jar org.zebra.RFIDSampledApp.RFIDSample4Aipp

Listening for transport dt_socket at address: 11@@l

Start the debugging application in the eclipse environment
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Click on the debug icon in the eclipse photon window.

Figure 100 : Open Debug View

Window Help
Bivit]or@-
FIDSample4App.] Debug |

A

Select Debug Configurations.

Figure 101 : Open Debug Configuration View

Window Help
=R R R - R Al
RFIDSample (no launch history)
534 Debug As >
535 - an e
536 Debug Configurations...

537 Organize Favorites.., ARAM

538

Select the created debug configuration and select Debug to start the remote application debugging.
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Figure 102 : Create Manage Run Configuration View

v : |
%l Rhino lavaSchpt
G Standalone VI VI
Juy Task Context Teat »
oL >

Filter matched 23 of 23 tems Bevert Apply

@ T

8] Debug Contigurations o
Create, manage, and run configurations
Attach to a Jave virtual maching scoepting debug connections
IR eimR|E Name: | RFIDSampledpp
type filter tet F Connect 1‘,: Source 1] Commaon
B Apache Torncat -~ Project:
& Eclipie Applcation [ 1 1 s
RFIDSampleddy .

Bl Echpie Data Took i e “

B Genenc Sercer Connection Type:

[ Genenc SercerExterna

Standard ket Aitach

B HTTP Preview . : -
B I2EE Preview Cennection Properties

0 Java Applet Host: [ 102.168.7.95

T Jeva Application -

o Mk Port: [ 11001

S0 unit Plug-in Test ] Allgw termination of remate VM

M Liunch Gioup

md Maven Busld

M Mode i Appheation
G LYS0 Ok

L Rernote Java Applicati

T RFIDSsmpledapp

Click on Switch.

Figure 103 : Switch View

@] Confirm Perspective Switch X

@ This kind of launch is configured to open the Debug perspective when it suspends.
This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to switch to this perspective now?

[[JRemember my decision
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Note : By default breakpoint is enabled in the zip provided. Hence, please resume so that the RFID

application comes out of the breakpoint.
Click on Resume icon as shown below.
Figure 104 : Resume Manage View

Run  Window Help
| oe |00 B &S

D Y Resume 55

1528

Note : On Photon eclipse , remote system explorer does not support SSH terminal. Hence, we need

to switch to Java perspective to visualise the output of RFID application on terminal window.

Select java Perspective on the eclipse window as shown below.

Figure 105 : Java Perspective View

HEIEE: TTE

g=sB v
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The application runs and displays the terminal output in the terminal view.

Figure 106 : Terminal Output View

Problem= @ lavadoc Declaration @Tenﬂinalﬁii

&) 55H rfidadm@192.168.6.58 (31/1/19 12:43 PM) 52

Listening for transport dt_socket at address: 11e8l
Connected to 127.8.8.1
Status: Function Succeeded Vendor Message: null

----Command Menu----
Capability
Configuration
Inventary

Access

Exit

(¥ N S WY S

8.7  Create Java JAR Executable
This section details the steps of JAR creation of RFIDSample4App using manifest file

8.7.1 Create the Manifest file of the project.
Right Click on project in the package explorer view and select New and click on Folder.

Figure 107 : RFID Sample New Folder View

i@} Zebra - RFIDSan Mew » (2% JavaProject
File Edit Source Go Into i Project..
O-E @ | I Open in New Window ¥ Package
[# Package Explon Open Type Hierarchy A | @& Class
v =2 RFIDSample Show In Alt+Shift+W > €% Interface
= FESE i Copy ctirc & Enum
v B e .
e 5§ org.ze B Copy Qualified Mame @ Annotation
& DR B Paste CirlsV &Y Source Folder
I :
Bl Referenc 3¢  Delete Delete 15 Java Working Set
[ Folder
Remnove from Contewt Ctrl+ Alt+ Shift+ Nown -
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Enter Folder name as “META-INF” and click on Finish.

Figure 108 : RFID Sample New Folder Name View

B MNew Folder = b

Folder

Create a new folder resource.

Enter or select the parent folder:

| RFIDSampledapp |

| e

= RemoteSystermsTermpFiles
- =2 RFIDSarmpledipp

Folder narme:

FAE Tt 1 IF

Advanced ==

&

Cancel

Right click on META-INF in the package explorer view and select New and click on File.

Figure 109 : RFID Sample New File View

I8} Zebra - Eclipse IDE
File Edit

JRa"

[ Package Explorer 53

Source

Refactor

Mavigate Search Project

Es|le Y= 0O

Run  Window Help

| @i -0 - Q- Q- B E- SO F/-@-iBinif-

v '_,:f- RFIDSampled o 3 2% Java Project
» B JRE Systen -
v B sre Open in New Window [ Project..
v i orgzek Show In Alt+Shift+W > | H¥ Package
» 441 RFIC
" D E| Copy Ctrl+C G Class
+ B, Reference
- o & Interface
= META-INF 55 Copy Qualified Name
T Paste Gl LB Ay
9 Delete Delere @? Annotation
ource Folder
S Fold
Remove from Context Ctrl+Alt+5hift+ Down 18 Java Working Set
Build Path » €5 Folder
Refactor Alt+Shift+T » g File
L

ZEBRA TECHNOLOGIES

vﬂjc:lv

68



Y ZEBRA

Expand the Project Name (RFIDSample4App), Select META-INF folder and enter File name as
MANIFEST.MF and click on Finish.

Figure 110 : RFID Sample New File Creation View

B Mews File
Fils

-
Create a new file resource.

Enter or select the parent folder:

RFIDSarmpledsm s WE TA- IMNF

= RemoteSystermsTempFiles
- L= RFIDSampledipp
Lo .settings
L= META-IMNF
L RFIDSarmpledipp_zekbra
= sre

I File name: | RMARIFEST.MF| I

Suchranced = =

Conce

Open the MANIFEST.MF file under META-INF folder in the package explorer view, add the following

3 lines with the valid-main-package and main-class-name, hit enter and save the file.

Manifest-Version: 1.0

Class-Path: . /platform/lib/Symbol.RFID.API3.jar
Main-Class: [main-package-name].[main-class-name]
Figure 111 : RFID Manifest Name View

ﬁ Zebra - RFIDSampledApp/META-INF/MANIFEST.MF - Eclipse IDE
File Edit Mavigate 5earch Project Run  Window Help

= | @ -0 - Q- Q- # G- &5 v - BFE
[# Package Explorer 53 = R"r_3.>| @ ~ - O

i
==
-
4
@
&
“
4
c_:)-
4
i
iy
4

|=] MANIFEST.MF &2

v'L_'—‘,Jv RFIDSampledApp 1Manifest-Version: 1.8
B JRE System Library [JavaSE-1.8] 2Class-Path: . /platform/lih/Symbol.RFID.API3.jar
- 3Main-Class: org.zebra.RFIDSampled4App.RFIDSampledApp
=4 a
~ i org.zebra.RFIDSampledApp I

_m RFIDSampledfpp.java
=i, Referenced Libraries
w = META-INF
= MANIFEST.MF

=
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8.7.2 Create and export the JAR executable:
Right click on the project name and select export.

Figure 112 : RFID JAR Export View

E Zebra - Eclipse I
File Edit Scurce
il = E
& Package Explors
~ =% RFIDSample:
» =i JRE Syster

~ B osro

~ & orgze "=

> &5 RFA| [&

» = Reference 3€
w = META-IM

Mew

Go Into

Open in Mew Window
Open Type Hierarchy

Show In

Copy

Copy Qualified Name
Paste

Delete

Remowe from Context

Ctrl+ A+ Shift+ Down

Alt+Shift+W >

Ctrl+C

Ctrl+W
Delete

F4

=] marn
Build Path »
Source Alt+Shift+5 »
Refactor Alt+Shift+T »
Exg Import...
n  Export...
In the Export select window, Expand Java and select JAR file.
Click Next.
Figure 113 : RFID JAR Export Resource Selection View
@] Export O >

Select

type filter text

Select an export wizard:

Export resources into a JAR file on the local file system.

> = General

> = BJB

» = Install

~ (= Java
. JAR file
@] Javadoc

> = Java EE

» = Run/Debug
> = Tasks

> = Team

> = Web

. o Waelh Sandicac

<‘¢ Runnable JAR file

> = Plug-in Development
> = Remote Systems

< Back Next >

Finish

Cancel
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Select the desired folder where the JAR file needs to be exported.

build\ (application_name).jar

For example :
“C:\Zebra-FXSeries-Embedded-SDK\samples\java\build\RFIDSample4App.jar”

Note: In the select the resources to export section, only select src and META-INF folder. Also, make

sure .classpath and .project checkboxes are enabled as per the screenshot below.

Click Next

Figure 114 : RFID JAR Export Destination View

i@} JAR Export O <

JAR File Specification

(@ The export destination will be relative to your workspace. | |

Select the resources to export:

~ [®] =2 RFIDSampled4App A (X .classpath
. &8 src M [X) .project
> [J &= .settings
> M &= META-INF

[4] Export generated class files and resources
[C] Export all output folders for checked projects
[[] Export Java source files and resources

[[] Export refactorings for checked projects. Select refactorings...

Select the export destination:

JAR file: I build\RFIDSampled4App.jar ~ Browse...

Options:
[[] Compress the contents of the JAR file
[[] Add directory entries
[[] Overwrite existing files without warning

@ < Back Next > Einish Cancel
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In the JAR Packing option window, select Next.

Figure 115 : RFID JAR Export Packaging View

& JAR Export | >
JAR Packaging Options - -
Define the options for the JAR export. | |

Select options for handling problems:

=] Export class files with compile errors

E-] Export class files with compile warnings
Create source folder structure

-] Build projects if not built automatically

[[] Save the description of this JAR in the workspace
Browse...

Cancel

(&) < Back Next > Finish

Select the Use existing manifest from workspace radio button and select Browse to browse for the

MANIFEST.MF file.

Figure 116 : RFID JAR Export Manifest Specification View

& JAR Export ] >
JAR Manifest Specification . ~
€3 No manifest file specified | )
Specify the manifest:
O Generate the manifest file
Save the manifest in the workspace
Use the saved manifest in the generated JAR description file
Browse...
@) Use existing manifest from workspace
Manifest file: | I Browse... I
Seal the JAR Details...
Seal some packages Details...
Browse...
() < Back Next > Finish Cancel
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Expand the both project name followed by META-INF folder and select MANIFEST.MF file.

Select OK.

Figure 117 : RFID Manifest Selection View

i8] Manifest Selection

Select the manifest file which should be added to the JAR:

~ L=2 RFIDSampled4App
> &8 src
> = .settings
~ = META-INF
= MANIFEST.MF
|X] .classpath
[X] .project

@

Cancel

Select Finish to invoke the build process.

Figure 118 : RFID Manifest Specification View

&5 JAR Export
JAR Manifest Specification

Customize the manifest file for the JAR file.

Specify the manifest:
(O Generate the manifest file

Save the manifest in the workspace

(@) Use existing manifest from workspace

Use the saved manifest in the generated JAR description file

/RFIDSampledApp/META-INF/MANIFEST.MF

Manifest file:

/RFIDSampled4App/META-INF/MANIFEST.MF

Seal the JAR

Seal some packages

® < Back Next >

Browse...

Browse...

Details...

Details...

Browse...

Cancel

Note: Select Yes if required to create the build folder and continue.
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Note : If there is a Confirm Create popup for JAR file, please click on Yes button.

If compile warning appears (as during the build), Select OK to continue if the warnings are

acceptable.

Note: click on Details to know more on warnings.

Figure 119 : RFID JAR Export Warning View

@] JAR Export O X

JAR export finished with warnings. See details for additional information.

ox

Exported with compile warnings: RFIDSample4App/src/org/zebra/RFIDSampledApp/RFIDSample
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EMBEDDED JAVA INSTALLATION PACKAGE SCRIPT

8.8  Create Start and Stop Scripts of Java Installation Package
This section details the steps to create script as a placeholder to enable user to create application

package. There are 2 scripts

1. Start_appname.sh : This script starts the executable once the application deb package is
installed on the RFID reader using web browser application console. The creation of deb
package is mentioned in section 9

2. Stop_appname.sh : This script stops the executable once the application deb package is
removed using the web browser application console.

Note: Execute ‘dos2unix’ tool for converting to unix text file format on scripts file. (For
Windows,
it is downloaded from https://sourceforge.net/projects/dos2unix/)

To create start and stop scripts:

1. Navigate to [Embedded SDK Install folder]\samples\java\build folder
2. Rename the script files to start_appname.sh and stop_appname.sh with the JAR file name
appname.jar.
3. Instart_appname.sh, replace the line:
java -jar /apps/%sampleapp%.jar &
with:
java -jar /apps/appname.jar &
4. In stop_appname.sh, replace the line:
EXECUTABLE_NAME=%sampleapp%.jar
with:
EXECUTABLE_NAME=appname.jar
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EMBEDDED APPLICATION INSTALLATION PACKAGE CREATION

9.0 Embedded Application Installation Package Creation

This section describes how to create an FX Series RFID Reader embedded application installation

package, and includes instructions on installing a package on a windows OS-based host system.
9.1  Creating an FX RFID Reader Embedded Application Installation Package

1. In eclipse Select Tools > FXSeries Application Package Builder > Execute.

Figure 120 : FXSeries Tools Selection

Project  Tools  Run  Window Help

i < F¥5eries Application Package Builder ] Execute
View Lo

. =] E g
Delete Log

Enter appname as the Package Name.
In the Maintainer (user name) field, enter the user ID of a reference person (no spaces).
Enter the Version (x.x.x).

Enter a short description of the application in the Description field.

A T o

In the Files(s) directory enter the [workspace]\build path (this must include start and stop

script files) and hit enter.

Figure 121 : Application Package CMD Window View

B¥ C\Windows\system3Ziemd.exe - C\Zebra-FXSeries-Embedded-SDK/tools/userAppPackageBuilder/userAppPackageBuilder.bat

ries-Embedded-SDK\samples\java\build
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7. Enter any Package Dependencies (up to 10) if this applies. After entering the last dependency the
install package is built.

Figure 122 : Application Package CMD Result Window View

ge Dependencies(up to 18):

Recommends

Replaces(
Build-Depends
Build-Confl
Built-Usin
{for more information wi
‘http://wn.debian.org/
Do you want to add depende

If there is no dependency, please press ‘n’ and hit enter.
The following screenshot depicts successful package creation.

Figure 123 : Application Package Creation CMD Window View

: RFIDSampledApp
] RFIDSampledApp
cture: all

Press any key to continue

After successful creation the package install file with the name [appname]_[version].deb is copied

into the folder [Embedded SDK Install folder]\buildPackages\all_build.
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9.2 Install and Uninstall Application Package on Zebra RFID Reader

Below listed steps will help in installing and uninstalling application package on RFID reader
Once login to web console of RFID reader

Step 1 : Application -> Install New Package -> Browse (Select the created deb package) .

Step 2 : Application package should be listed in List of installed apps as shown in figure below.
Step 3 : Click on Start or Stop circular button to Start or Stop the application executable.

Step 4 : To Uninstall or remove application package, click on uninstall button in the figure below.

Figure 124 : RFID Reader Web Application Console

< € ® Notsecure | 192.168.6.58/readerindex.htm| % @ O s = @B 8 “ o X Pausedo

i Apps  d Bookmarks Imported From IE O SENCHA GITHUB o SenchaTest ODC [ SenchaTest Training & MANU GOOGLE AC € Cognomotive E2E " Testlink 1.9.14 (Pac. » Cther bookmarks

FX9600

rome User Application Page Applications

B o This page provides he details of installed application and also io
¥ Operation Statistics —————————FExisting Packages: install applications in the reader.

¥ Configure Reader List of Installed apps Start/Stop AutoStart Uninstall
» List of installed Apps - This drop down menu shall list the

Read Tags RFIDSampledApp ¥ [ ] 0 Uninstall current packages installed in the reader

» Communication = Start/Stop - The image displays the running status as indicated
below. Click the image to toggle the status.

Date Time Meta Data I ge to toggl

S Package Name RFIDSampledApp ' _Indicates App is running
’ Package Version: 1.0

i Status: install user installed

Change Password architecture: all

6PI0

Indicates App is NOT running

« AutoStart - Selecting this check box shall enable the application
to run at startup.

Applications P.
= Uninstall - Shall remove the package from reader.

Profiles

» Firmware Install New Package: - How to create packages: Packages can be crealed using any of

standard debain package creation tocls or manually. The guidelines
S = for package creation for FX Series reader are listed below,

ystem Log urrent 1. The package shall contain binary executable compatible of ELF
hasiics Status: S e Ik 2R A 3-bit LSB executable, ARM, version 1, GNU Linux

Commit/Discard

. 2. The name of the binary executable must malch the name of the
Shutdown EEEEE || Browser package, excluding ve me. For example, if the package
name Is package-1_2.1_all (package-1 version 2.1 ), then the name
Loaost of binary executable must be package-1. There can be more
binaries apart from the above said one in the package.
3, The package shall contain a startup scriptin the name of
start_packageName sh to start the above said binary ( andor ofher
binaries in the package, if any) . For example, if the package name

© Copyright 2019 Zebra ies. All Rights Reserved

From Reader login as ‘rfidadm’ and execute installed RFID sample application as ‘java -jar
/apps/RFIDSample4App.jar’.

Note: Start and stop circular button/auto start of RFID sample application ‘RFIDSample4App.jar’ is
not applicable from RFID web consle, since application need user input from console.
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